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4th Tuesday, May 28, 2013, 4 to 6 PM
Frank Tona of Crown Camera

has generously signed on again for us to
cover the how-tos of spring photo contests
(some sponsored by Crown Camera “May Is
Photo Month”) and to present the newest
equipment for taking the best of photos!

Frank is always so informative and fun to have an evening with.
Don’t miss out!

Door Prizes
1. $30 Cash Prize!

CUGR
Calendar
CUGR Board Meeting
1 PM Tuesday, June 4, 2013

2. $15 Cash Prize!
One free ticket to each
member at the door!
Also 3 tickets for a dollar
Or
8 tickets for 2 dollars
Or
20 tickets for 5 dollars

4 pm Social & Business

& 4:30 Presentation

Social time & club updates. 4:30 Presentation
Sign in at the Greeting Table and pick up your
name tag and please leave it in the Tag Box
when you leave. Also please stay and help reset
the tables to the Library’s original arrangement.

Watch for change of time in June & July
June Meeting is to be announced

at Redding Library in the
Foundation Reading Room

MULTI-MEDIA
Note: NO SIG IN MAY
10 AM, Saturday, June 22

Jane Quinn SIG Leader
Digital Devices, usage of
free software for Movie
Creation, Photo Projects,
Music Projects, and Social
Networking, and more.
See back page
for more SIG information

GENERAL MEETINGS ARE
at the Redding Library
1100 Parkview Ave,
off Cypress.

OFFICIAL WEBSITE IS

http://cugr.apcug.org/
For more information
call any Board member
listed on Page 2.
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Motherboard Newsletter Policies and Deadlines
The Motherboard newsletter is published
monthly by the Computer Users Group
of Redding, PO Box 494778, Redding,
CA 96049-4778. The CUG is a 501(c)(3)
non-profit corporation. Subscriptions are
included in the $25 annual membership
fee. The purpose of the newsletter is to
inform members of upcoming events and
provide information about the use of IBM
compatible computers.
Disclaimer: Neither the CUG, its Officers,
the Editor, nor the newsletter contributors
assume any liability for damages incurred
due to the use of information provided in
this publication.
Reprints: Articles from this newsletter
may be reprinted by other user groups
if credit is given to both the author, CUG
and the Motherboard. Mail a copy of the
newsletter where the article is reprinted
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to the Editor at the address in the first paragraph of this text.
Personal Ads For Members:
Requirements are:
1. Advertiser must be a member.
2. The item must be computer-related.
3. The ad must be received by editor J. Ball
by the monthly date of the board meeting.
Sorry, no exceptions.
Other terms must be approved by the club’s
Board of Officers and Directors.
Article Submissions: All articles and reviews must be submitted to J. Ball by the
Monday of the monthly Board meeting
(see Page 1 for date.) Sorry, no exceptions.
Motherboard Editor reserves the right
to make corrections and deletions in all
articles in the interest of grammar, style,
and space.
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President’s Message

I have come to the conclusion that it
is only a matter of time before someone
hacks into my computer. When I read
in the paper that the Pentagon or some
Bank has had its system hacked, I figure
if they can get into those machines, mine
should be a cinch. With this in mind, I
have been checking my documents to
see what is there that could be harmful to
me if someone stole it and use the information to set up a false I.D. I have deleted
a number of items with this in mind.
I have heard about a protection information feature with an incription program.
I heard it was part of Windows 7 and the
newest Word program. I learned from
someone a lot smarter than I that it is also
available in older versions of Word.
I have a couple of documents I did
not want to delete because I update
them from time to time with financial
information. My friend showed me how
to do it with Word 2000.
I opened a document in Word 2000.
After making the changes I wanted, I went
to the header “Tool”, then chose “Options”.
I opened the “Compatibility” section and
there it was, “Password to Open”. I chose
a password and then closed the document. I tested it and sure enough, I could
not open it without the password.
I want to send the document to a
daughter, but do not want to send it
via email. So I set up a test document
and protected it with a password. I then
emailed it to myself to see what would
happen. Google would not let me "view"
the document, but I could download it. I
downloaded it, and found I could not open
it without using the password I had used
to create it. Cool. So what I will do is call
my daughter and give her the password
on the phone, then send the document.
Now, I can continue to update this document from time to time and not have to
take it off my computer.
Ed Beaulac

Editor’s Corner
Folks, I want to apologize to Ed because by a couple of innocent errors, I
put a condensed version of his PC tip
in last month’s President’s Message.
But being condensed it was not near as
detailed as his full article above. I put it in
again this month as he intended, so the
reader would benifit from the full tip.
Bill, and I, and our family (9 adults)
are taking a cruise to Alaska on the
17th. We’ll be back by June.
Judi Ball
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April Meeting

Marlene Robinson and
Bernice Bennett came
forward to speak of Windows 8, and they did a
great job of taking some
of the fears of yet another
operating system coming
into our lives.
Thank you, Ladies!

Congratulations To Our Winners!
CUGR
MEMBER WEBSITES

Margot
Lintendre
won the
Canon printer
that scans,
copies, prints,
& prints on
CDs/DVDs!
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MEXICAN-TOURS
www.mexican-tours.com
Lyle VanNorman
bbcreelmx@yahoo.com

$30 Cash

Anna Lee
Horton
won the
$30 cash
prize!
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Publicize Your Website
Here for FREE!
(Members Only Please)
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Welcome Renewals

Dean Ellison
Dick Franks
Joe & Mary
Adams
Larry Elliot
Mary Montague
Michael Gudzan
Norm & Lynn
Johanson
Shirley Parker
Ted & Janet
Hering
Fred Skill’s Tips:
Quick E-mail Sorting
How many e-mails do you get in one
day? I get about 50 to 60 every day, so
I definitely use this tip, and I’m sure you
can probably put it to good use as well! So
you sit down at your computer, preparing
to sort through a huge list of e-mails while
wishing you knew of a quick way to find
the specific one you need, right?
Well, put on a happy face and smile :-)
because there is!
To get MS Outlook or Outlook Express to sort e-mail, all you have to do
is click!
When you're looking at your inbox,
do you see the column titles at the top,
the ones that label the columns From,
Subject, Received, etc?
Simply click on the column title you
wish to sort by.
You should notice a little arrowhead
appear in the title bar, which indicates
the direction of sorting.
An arrow pointing up will sort messages ascending (A to Z or oldest date
to newest).
An arrow pointing down will sort messages descending (Z to A or newest
date to oldest).
One click and you're on your way to
finding that one specific e-mail ASAP!
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Choosing The Right PC Speakers
(NAPSA)—Today, millions of people
are downloading music, watching
DVDs, and playing video games on
their PC. Many of them are looking to
upgrade their PC sound system for a
better multimedia experience, knowing
that a good set of speakers can transform ordinary digital audio into a prime
seat at a concert.
But choosing PC speakers can be
confusing. When you walk into your
local electronics store, the multimedia
speaker area is overflowing with 2.0,
2.1, 5.1 and even 6.1 speaker systems.
How do you know what’s best for the
type of listening you do at your PC?
Here’s some help in sorting it all out.
2.0: Two satellites: A simple speaker
pair is the most basic PC setup. Installation is easy, since this speaker configuration is compatible with standard
PC soundcards. The 2.0 is an entry-level
system, which works best for people looking for basic PC sounds such as “You’ve
Got Mail” when you log onto e-mail.
2.1: Two satellites, one subwoofer: If
you’re an avid PC music listener, consider
a 2.1 system, which includes a subwoofer
(note: the .1 means the system includes
a subwoofer). A subwoofer is better able
to handle the bass frequencies that make
for a richer listening experience. Although
almost as easy to install as a 2.0 system,
the addition of powerful bass dramatically
enhances any music.
5.1: Four satellites, one center speaker,
one subwoofer: This configuration takes
a 2.1 model and adds two rear satellite
speakers plus a front, centerspeaker—
giving you true surround sound. With a
5.1, you can experience true positional
audio, meaning you can hear sound
from all directions while playing games
or watching videos. So you’ll actually
know when the enemy is sneaking up
from behind! To take full advantage of a
5.1 system, you’ll need a 6-channel PC
soundcard (check your soundcard manual
to determine compatibility, or consult your
local electronics store for assistance).
6.1: Four satellites, one front center
speaker, one rear center speaker, one
subwoofer: A 6.1 speaker system is similar to a 5.1 speaker system, with the addition of a dedicated rear center channel,
for better positioning of rear sound effects.
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SOUND IDEA: Success is
finding a speaker system that
brings your multimedia PC experiences to life.
This system is most appropriate for PC
gaming, as there are now some games on
the market that are encoded to produce
true 6.1 surround sound. This is not an
extremely popular configuration, however,
since there are a limited number of true 6.1
sound sources. With a 6.1 configuration,
a 7- channel PC soundcard is necessary
for true 6.1 surround sound.
Some people think the price of speakers is based solely on the number of
pieces—but in reality, many 2.1 speakers
cost more than 5.1 or even 6.1 systems.
System prices are based on both the number of pieces and the power output. First,
identify what configuration you want; then
determine how much power—expressed
in wattage —is needed. The higher the
wattage, the higher the price. Wattage
indicates how much power a speaker
system can deliver. It’s important to note
the RMS wattage on each system. Since
the FCC sets standards for RMS power
measurements, this specification can
be used to compare similarly featured
systems. Depending on your sound
needs, you might find systems with 40
watts adequate, while others want the
earth-shaking power of a 400-watt system. Many times, power needs can be
determined by the size of the room you’re
hoping to fill (40-70 watts is perfect around
the PC, while 400-500 watts is needed to
fill a large family room).
Besides deciding on power, check to
see if the speakers offer any third party
technologies or certifications, such as
THX. THX certification ensures that the
product has been tested and approved
by an independent audio authority and
meets certain power and clarity measures—premium high-end products will
carry the THX seal of approval.
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Giving Internet TV A Try
by Gene Olson, Member,
ICONPCUG, Long Island, NY
11-2012 issue, The ICON Graphic,
www.iconpcug.org, Editor@iconpcug.org

After getting the Cable bill, I wanted to
reduce the rates by having Internet TV
(and cutting out Cable). After reading
about “Satellite Direct”, which seemed
like it was better than other Internet TV
software – I bought it. It cost $50 over
the Internet. I would NOT recommend
using a regular credit card.

PROS:
·
·
·
·
·
·
·
·
·
·
·
·
·

It does give you a lot of channels.
Lots of channels are in English.
They do provide music channels.
The quality on most channels is
great.
Some channels are the same channels on Cable TV.
It has a nice menu to select Video by
country.
It has a nice ability to Search Video
from any country.
The channel changing is fairly
quick.
Even some of the foreign channels
are in English (Brazil TV had the
Beatles in English).
It does have the ability to get some
channels from HBO, Showtime, Cinemax, etc.
It’s better for a person who knows foreign languages to get other country
channels.
Lots of channels are from Satellites.
The one-time $50 fee is not bad to try
the product, get connected to Internet
TV and without a monthly charge.

CONS:

· It does not allow you to install it on
any other computer (even one you
own).
· It didn’t provide as many channels as
they indicated (3500).
· Many channels are from foreign
countries.
· Some channels don’t load.
· I can’t get all the channels that I can
get on Cable TV.
· Some channels have software in front
of it that you have to get around.
· Some screens are blank.
· Some channels are slow (requiring
10 seconds to connect).
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Bits And Pieces

by Rush Blodget; IMB/PCUG of Redding, rblodget2@yahoo.com
Disillusion! How many of you have
bothered to enlarge the number “4” type
font to a readable size in that long paper
on Privacy Policy and End User Agreement that we are all asked to sign? For
some unknown reason I did so. I was
naive enough to sign one such agreement recently, but then remembering
a real estate seminar I had attended
many years ago where the instructor
said, and not facetiously, that the way to
make money in rentals was to buy some
standard landlord-tenant forms at the
stationary store (always fine print) and
pay to have them reprinted with harsh
terms interspersed for the tenant and
easy ones for the landlord. The unsuspecting tenant having seen such forms
before would possibly not bother to read
them. The fine print thus worried me.
I was notified of an upgrade to a
well-respected program offered by a
trustworthy vendor — I had no reason to
suspect that malware might be indirectly
associated with the download. However,
it sneaked in by way of a box on the
download page stating that it might be
necessary to first download an upgrade
copy of a facilitating program such as
Adobe Reader. I am reluctant to name
the vendor involved because the vendor
of the software being upgraded provided
a long disclaimer of the associated potential malware. I found this type of deception on several other sites as well.
I will quote verbatim extracts from
the enlarged and now readable text
“... agree to be legally bound by the
XXXXX combined end-user license
agreement and privacy policy…” Up until
now I thought that a Privacy Policy was
a document that stated what the vendor
would do to protect the user. In this case

it seems to be entirely
to protect the vendor
that “piggy-backed”
his way in.
“...licensed to you
on an ‘as is’ basis.”
“... XXXXX may incorporate technology,
software and services
owned and controlled by third parties...
you agree to look solely to the applicable
third party and not to XXXXX to enforce
any of your rights, because XXXXX reserves the right to add additional features
or functions to XXXXX. When installed
on your computer,” the software service
and site may still be vulnerable to various
security issues and should not be considered secure.
“IF YOU DO NOT WISH TO BE
SUBJECTED TO THESE RISKS YOU
ARE ADVISED NOT TO USE XXXXX
OR SERVICE.”
The document then went on to encompass the usual content of privacy
agreements.
The point to this article is that one must
always verify the source of a potential
downloadable program by going directly
to that software’s home page and checking their status first. This also may be
difficult due to the “phishers” replicating
entire web pages now-a-days.
The Department of Defense several months ago admitted that “they ar
smarter than we are” and decided to
form a cyber-security team or corps.
I am personally disillusioned by the
fact that our wonderful Internet that
recently held such promise has been
so degraded by “phishers” and hackers
that we are becoming afraid to use it to
its full extent.

· Some content on some channels
repeat.
· Some channels are not online all
the time (understandable for other
countries in a different time zone).
· Some channels the audio runs, but
the video stops, and/or the video
jumps.
· Not good if you only know English
(like me) and there are many foreign
language channels.

· It seems the same advertisements
are on multiple channels – seems to
be from “Satellite Direct.”
· Once installed, the software wants
you to upgrade to their PREMIUM
PACKAGE at $5/month.
I read an Internet review that some
Internet TV software overflows the buffer and downloads viruses and malware
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Continued on Page 6
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Multi-Media SIG UpDate

by SIG Leader Jane Quinn, qjquinn7427@gmail.com
Thursdays, 1-3pm, you’re invited to join us at the Senior Center in
Anderson for a computer session in the classroom. For special projects I will give individual help at 3 pm. Contact me before to ensure
I set aside time to devote to your project.You can also connect to the classroom
at high speed internet through SKYPE. ID is AAASCO2009.
Our monthly Multi-Media SIG is Saturday June 22 at our home from 10 am to
noon. For directions contact me via e-mail above or phone, 365-0825.
Each winner purchased his/her
There will be no Saturday SIG in
tickets at varyous times during the
May. That date falls on the Memorial
three month period for the drawing:
Day weekend.
during a general meeting, by mail
Just a mention, and a “thank you“ to
to me, or during a SIG class prior to
Marlene Robinson and Bernice Bennett
the monthly drawing. There were no
for their presentation at the April Gen

eral meeting. We are so lucky to have
members who volunteer to get up in front
of the group and generously share their
knowledge. In the bumpy road ahead,
as we all struggle with new “stuff,“ it is
so rewarding to see our peers overcome
this digital quagmire. And particularly
comforting is they’re willing to help us in
the struggle. I’ve said it many times, this
is why people join this club!
I would like to mention the success of
the last 3 Drawings. The prizes were a
Computer monitor, $200, an Amazon gift
certificate, and a 50/50 raffle worth $105
to the winner. The raffle proceeds were
$210, and half that amount went to the
winners, Joe and Mary Adams. Prior to
pulling the winning ticket I passed around
the jar with all the purchased tickets and
let everyone give it a good “shake.“

winners present for the drawings. And
you’re not required to be present to win,
but it is ironic that so far there were no
winners in the room with us. I think we
would have loved to have seen their
smiling faces.
We will have another 50/50 drawing at
the July Ice Cream Social, and as before
you can purchase your ticket(s) from me
anytime before the drawing date. So I
encourage everyone to participate.
If you have comments or ideas about
raffles, please tell a Board member,
myself included. It’s your club let’s hear
from you!
See you at the next general meeting or
at the Anderson Senior Center Frontier
classroom on Thursdays 1-3pm. Remember I‘m there after class 3 to 4:30
PM for tutoring.

Crossword Puzzle History
Metro News Online

Crossword puzzles are a form of
entertainment all over world. They
appear in newspapers and crossword
books and serve as a tool for educating children. Crosswords have been in
existence since the early 1900s.
A crossword puzzle is a word game in
which players use clues to fill in a grid
of boxes to complete words both vertically and horizontally. Arthur Wynne,
an English-born journalist at the New
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York World, is credited with inventing
the crossword puzzle.
Wynne based his word-cross, as it was
originally named, after an ancient game
that originated in Pompeii, translated
from Latin to mean "magic squares,"
which Wynne had played as a child. The
first puzzle was a diamond shape.
The World published Wynne's crossword puzzle in its 8-page "Fun" section
Continued on Page 10
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$$$ 50/50 Cash
Raffle! $$$
This is The Next
CUGR Drawing in July
“50-50 Raffle” stands for whatever cash is raised. The winner
will get half of the cash. That way
the Club would not be in a position
where the prize might cost more
than we took in on the raffle.
Tickets will sell for $5 each, or 3
tickets for $10. And you need not
be present to win. So make certain
that you print your name and phone
# on the ticket(s) you buy.
Tickets may be purchased
anytime before or during the
July meeting up to the moment
of the drawing, or during any
of Jane Quinn’s classes, or by
mailing a check to Jane Quinn.
(By the way, the Quinns are not
participating in the drawing.)
You can buy tickets from Jane
by mail (email or call her for the
mailing address) or during general
and SIG class meetings. If you mail
the money to her, she will assign a
ticket(s) and hold it for you until the
drawing on July 23, 2013.
qjquinn7427@gmail.com
phone: 365-0825

GIVING INTERNET TV A TRY
Continued from Page 5
to your computer. They were right, after
three days – I had a Trojan on a computer that never gets viruses and is not
used for the Internet. I will now have to
run constant full Virus Protection scans
on my computer more often.
REVIEW: The software could be written a lot better, without viruses, without
advertisements, without distracting
screens. They don’t tell you what you
get with $5/month more premium package. I would not recommend it, primarily
because of the viruses. But if you do
use it, use on a spare computer (one
that you can reformat).
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Permissions – Do You Have The Right Ones?

Phil Sorrentino, Member, Sarasota PCUG, FL, March 2013 issue, PC Monitor, www.spcug.org, philsorr@yahoo.com
In the early days of computing, when
we didn’t have multi-users Operating
Systems and networks, permissions
were less necessary because the
files and folders created were for the
use of the one and only user. Files
were shared using floppy disks and
sneaker-net (run with the floppy from
computer to computer). But, as operating systems improved and allowed
multiple users and our computers were
connected by Ethernet networks, permissions became necessary to make
sure only those intended could view or
change your files and folders.
If you have ever tried to share a folder
on one of your computers on your home
network, you know how frustrating it can
be to get things to work. Well, “permissions” is one of the things that has to
be understood and setup properly. Of
course, there are many other things that
have to be set up first, but permissions,
often times, is a stumbling block. If you
are setup with a “Homegroup” (all machines are running Windows 7), then the
job is a little easier than if you are setup
with a “Workgroup” (machines can be
running XP, Vista, Windows 7 or even
be Apple computers). All the computers
in a Workgroup must be setup with the
same workgroup name (check in the
System control panel for this setting, on
the computers running Microsoft OSs).
Permissions may be a challenge
because there are two types of permissions to be considered. There are “share
permissions”, and NTFS permissions.
Share permissions are necessary when
accessing folders across a Local Area
Network (LAN), from another machine.
NTFS permissions are necessary when
accessing any file or folder that you do
not own (i.e. created it yourself). So,
both permissions must be set up when
you are trying to share files and folders
on a LAN. Share permissions are easily
setup for a file or folder. Just right-click
on the file or folder you want to share (in
Windows Explorer) and choose “Share
with” and then select those that you
want to share with. (Selecting “Specific
People” will open a window that will let
you select those people you would like
to share with. Pull down the arrow and
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select “Everyone” and then click “Add”,
if you would like to share with anyone
on the network. But keep in mind that
“Everyone” includes anyone you let onto
the wireless portion of your network. Be
especially aware if you do not have your
network protected with at least WEP
encryption.)
The NTFS permissions are the next
things to consider. NTFS permissions
is a core component of the Windows
7 security system. Using this feature,
you can specify exactly which other users are allowed to open your files and
folders, and how much they can do with
the files and folders. Using Windows
Explorer to setup the NTFS permissions
for a file or folder, right-click the file or
folder and select “Properties”. In the
Properties window, select the Security
tab. Here you will see a list of Users and
the Permissions for each User. Click a
User in the “Group or user name” box
and the permissions will be shown in the
“Permissions for Authenticated Users”
box. In this box you can Alllow or Deny
the following Permissions “Full control,”
“Modify,” “Read & execute,” “List folder
contents,” “Read,” “Write,” and “Special
Permissions.” (You would think that
Deny is just don’t Allow, but there are
further details that complicate this issue
and it would take more than the length of
the Monitor to completely explain, however there is a good description of these
issues in the best seller “Windows 7, the
missing manual”.) A brief explanation of
these permissions is as follows:
· List folder contents, which can only
be set for folders, allows a user to
see the files and folders inside the
folder.
· Read allows a user to examine the
contents of the file or folder, but not
make changes.
· Read and execute allows a user to
examine the contents of the file or
folder and also run any file that is in
the folder.
· Write allows a user to read a file and
make and save changes to it.
· Modify allows a user all the abilities
of Write and Read and execute, and
also allows the ability to delete the
file or folder.
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· Full control allows a user to do anything to the file or folder, including
changing its permissions, and even
taking ownership of the file. (Ownership is normally given only to the user
who created a file or folder.)
· Special Permission seems to be fairly
extensive and best described by an
article from Microsoft at:
http://support.microsoft.com/kb/308419
This is a little to the side of the topic
of Permissions, but it is related. You
will notice that there are two levels of
Computer Users, Administrators and
(Standard) Users. Administrators have
permissions to create, delete, and
manipulate files and folders. Administrators can also execute programs,
install programs, create accounts and
change permissions. Some of these
can be very dangerous in the hands of
a malicious person or piece of malware.
(There must be at least one Administrator for every computer.) (Standard)
Users typically have fewer permissions,
but permissions can be increased as
previously discussed. Microsoft recommends, for security reasons, that there
be only one Administrator, and all other
Users be the (Standard) User type. This
is probably good advice for most installations because of the extent to which
an Administrator can manipulate files
and folders. Should a virus or Trojan
horse get control as an Administrator,
the malware could easily wreak havoc.
But with the lesser permissions of a
Standard User, the malware may be
thwarted and not be able to pull off its
nasty job.
Setting the share permissions for
different Users on a file or folder can
be done if necessary, but if you are
on a small LAN and all the Users are
known to be trustworthy, then when it
comes to sharing a file or folder, you
might consider sharing with “everybody”. And set the NTFS permissions
for each User to what that User needs,
and no more. This will probably help
make it easier to setup your network
and share files and folders on that
network, and if a problem occurs, it
should make the troubleshooting less
difficult.
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SkyDrive & Office Web Apps

by Lynn Page, Editor/Webmaster, Crystal River UG, FL, 4-2013 Newsletter issue, www.crug.com, lpage46@tampabay,rr.com
With a Windows Live ID you have
access to Microsoft’s Office Web
Apps. This lets you open, edit and
share Word, Excel and PowerPoint
documents online using SkyDrive. So
you can work with your documents
from any computer whether it has the
Office applications installed on it or
not. Go to http://skydrive.live.com in a
web browser to log on or sign up for a
Windows Live account.
Store Office documents on SkyDrive
to view and edit them in a browser. Or
share documents stored on SkyDrive
by linking to them in an email, blog or
social network.
Save to or Upload to SkyDrive
Documents generated on your home
computer can be saved to SkyDrive or
uploaded. Use Save & Send to save
an existing Word, Excel, or PowerPoint
file. Select Save to Web, Sign in to your
Windows Live Account, and then click
Okay. Specify a folder on SkyDrive, and
click Save As. Type a name for the file
and click Save.
I think it is easier to create the
document, save it on the hard drive,
and then upload it to SkyDrive. In the
SkyDrive menu bar click Upload. Then
either drag and drop files from your
Documents folder to the upload box or
browse to and select them for upload.
To open a document in SkyDrive, select
the folder where document is saved,
and click the file name.

C REATE NEW DOCUMENTS IN THE
WEB B ROWSER

With the Office Web Apps you can
create Word, Excel or PowerPoint
files right in a web browser. The Office
application doesn’t have to be open or
even installed on the computer.
Sign into SkyDrive and click the kind
of document to create in the Create
drop down menu. In the dialog box type
a name for the document and click the
Create button.
A new document opens for editing in
the appropriate Web App. Simply create the document as you would in the
Office application. The Web App will
not have the full features of the Office
2010 application but is familiar.

SHARE FILES ON SKYDRIVE
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SkyDrive allows you to share your
Office documents, photos and other
files. You can share individual files or
an entire folder. In SkyDrive locate the
folder or file to share and place a check
in the selection box. Click Sharing on
the Menu bar. The default method of
sharing is by email. This lets you give
specific people permission to access
and even edit your files. Add the email
addresses for those who will be reviewing the files, add a message and
click the Share button. To access the
document the recipients must have an
account or create one.
The Post to option places a link to
your SkyDrive files on a social media
service like Facebo okay. I wouldn’t
choose this method of sharing as it
is open to any of your friends or their
friends if they repost.
The Get a link sharing option creates
a link you can send to others. The advantage is they do not need to have a
SkyDrive account. The disadvantage is
that anyone with the link can access the
file. I would use the View only option for
sharing a link. It allows anyone with the
link to see the file. The View and Edit
link allows anyone with the link to see
and edit the shared files. If you select
Public sharing, anyone can search for
and view the public files.

SHARE FILES ON SKYDRIVE

SkyDrive allows you to share your
Office documents, photos and other
files. You can share individual files or
an entire folder.
In SkyDrive locate the folder or file to
share and place a check in the selection box. Click Sharing on the Menu
bar. The default method of sharing is
by email. This lets you give specific
people permission to access and even
edit your files. Add the email addresses
for those who will be reviewing the files,
add a message and click the Share
button. To access the document, the
recipients must have an account or
create one.
The Post to option places a link to your
SkyDrive files on a social media service
like Facebo okay. I wouldn’t choose this
method of sharing as it is open to any of
your friends or their friends if they repost.
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ORGANIZE/MANAGE SKYDRIVE
SkyDrive storage can be managed
in a similar way as Documents on your
hard drive. A new SkyDrive account
will have three folders: Documents,
Pictures and Public.
Create new folders with the Create drop down menu. Folders can be
nested within these three main folders
or added on the main file location. Go to
the location to add a folder, click Create
and select Folder from the drop down
menu. Enter a name for the folder and
it is all set for storing files. The path to
the files or folders is shown in the title
bar. The number in the bottom right
corner of a folder shows the number
of files it contains.
If you change your mind about how
folders should be organized you can
move them. To move a folder, go to it
in SkyDrive. On the Main menu click
Folder actions and select Move folder
to or from the drop down menu. In the
dialog box add a new folder or select
the location to move the folder.
The Manage drop down menu is used
to manage files. It allows for renaming,
deleting, moving and copying files.
The trick is that you must go the folder
containing the file and place a check in
the selection box. That opens additional
commands on the Menu bar.
To move the file, place a check in the
selection box (top right corner), click
Manage in the Menu bar and select
Move To in the drop down menu. In the
dialog box select the location for the file
to be moved.

WORD WEB APP

The Home tab contains basic text and
paragraph formatting including Styles.
The Insert tab is used to insert tables,
pictures, clip art and links. To insert a
table in the Insert Table drop down,
point to the number of rows and columns and click.
Clicking the Picture icon opens Windows
Explorer to select a picture to insert
into the document. Browse to and
select the picture and click Open. The
picture is uploaded and inserted into
the document.
Continued on Page 9
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Outlook.com

by Lynn Page, Editor/Webmaster, Crystal River UG, FL, 4-2013 Newsletter issue, www.crug.com, lpage46@tampabay,rr.com
Microsoft has upgraded Hotmail and
Windows Live to a new Outlook.com
cloud email service. My accounts were
just ‘upgraded’ this week. It is always
hard to make changes so I will let you
know what I have seen.
The introductory email has links to
get started with Outlook where you can
read information about the service, get
a new email address, connect your account with your social media accounts
and provide feedback. I have more than
enough email addresses to keep track
of and don’t want to connect my email
with my Facebook accounts so I didn’t
even look at those options.

INTERFACE

The Outlook interface has been streamlined from the Hotmail interface. It looks
cleaner and takes less screen space.
That can be important if you are checking
email from a small portable device.
One notable feature is that the menu bar
only shows message items when an email
or emails have been selected. Without that
the only item is the New Message icon.
Further streamlining is seen in the
filtering options. In Outlook to filter

SKYDRIVE & OFFICE WEB APPS
Continued from Page 8
Clicking the Clip Art icon opens
a search box. Type in a description
and click the search symbol. Browse
through the clip are pieces, select one
and click the Insert button.
Once a picture or clip art has been
uploaded a Picture Tools Format tab
appears when the graphic is selected.
Tools are available to Grow or Shrink
the picture and add a Picture Style.
The Page Layout tab specifies page
setup and paragraph indent and spacing. Page Setup options include margins, page orientation and size.
Save the document when it is complete. Clicking Save on the File tab
saves it on your SkyDrive. Clicking
Save As allows you to download a copy
and save it on your hard drive.

EXCEL WEB APP

The Home tab has font formatting and
alignment, number formatting and table
formatting. The Cell commands allow for
insertion or deletion of rows, columns, cells
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CLEANING UP

delete emails in bulk from multiple senders, cleaning out hundreds of emails in
seconds. It will also move all email from
a sender to a specified folder.
If you tend to subscribe to every
newsletter that comes along only to find
out you don’t read them Unsubscribe is
a great feature.
Set simple rules in Sweep to automatically file emails from specific senders to a folder of your choice. The email
won’t even go to the inbox. Sweep
lets you file emails straight to a folder
automatically based on the sender's
email address.

I try to keep my Inbox, Sent and Deleted
folders clean. This means that I either
delete email from my Inbox or save to
an offline folder on a regular basis. I also
delete Sent emails and empty the Deleted
folder ever few days. If you don’t want to
take care of this yourself use Sweep or
schedule a cleanup. Sweep works based
on the email sender. Schedule a cleanup
lets you select to keep only the latest
email from a sender and delete the rest,
delete all messages after 10 days or move
them to a selected folder. Sweep can also

OFFICE ONLINE AND SKYDRIVE

Outlook is designed to work seamlessly with Microsoft’s free Office Web Apps.
So you can open, edit, and share Office
files right from the inbox. This is great if
you or the recipient is using a computer
without Office installed. Integration with
SkyDrive makes sharing and saving your
files simple in 7 GB of free storage space.
To share files place them in SkyDrive and
email a link. Recipients can see photos
and documents, even if they don't have
Office on their computer.

and new sheets. The Formulas group includes the commonly used functions. The
Data group can refresh the workbo okay
connections and recalculate or search the
workbo okay to Find something.
Insert Functions, Tables, Charts and
Links from the Insert tab. The number of
charts available is limited but sufficient.
The View tab has only two options.
You can use the standard Editing View
or choose Reading View to look at the
data without toolbars.

ed but you still have styles, fill and outline.
I like the new Delete group as it provides
one click option to delete a slide.
The Insert tab has a New Slide button to open the dialog to select a slide
style to add to the presentation. Adding
pictures and clip art is same as in the
Word Web App. Shapes and SmartArt
are added in the Illustrations group.
The Text group contains the Text
Box icon.
The Design tab offers the same themes
and variations shown in creating the presentation. So if you decide that the selected
theme isn’t working, change it to one more
suitable. Set the animation on the slide and
timing or reorder the animations on the
Animation tab. Slide transitions are limited
to none, fade, and push and are controlled
on the Transitions tab. The View tab has
three Presentation Views as well as Notes
and Comments. The Editing View is the
normal view you would use in PowerPoint
with slide icons for selecting or sorting and
the active slide pane. The other options are
Reading View and Slide Show.

messages, click View All and select a
filter category.
Another nice feature is the set of
icons that are displayed when you
mouse over a message. Click the icon
to reply to, trash or flag the message.
Outlook Folders and Quick Views
are the same as in Hotmail. You can
define rules to automatically handle
messages as they come in like flagging
messages, moving them to folders and
setting alerts for your mobile phone.
Quick Views automatically sorts and
shows items by category.

POWERPOINT WEB APP

When creating a PowerPoint presentation on the web app there is a very
limited number of themes. In the first
dialog box chose a theme. There are
also four customize buttons that change
the color scheme. Once the theme has
been set and the Apply button clicked,
a new presentation opens.
The Home tab has the Clipboard,
Slides, Font, Paragraph, and Drawings
groups. The font and paragraph formatting commands are limited to the basic
functions. The number of shapes is limit-
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Who's Driving This Bus Anyway?

by Dave Helmer, Past President and Co-Founder, Computer UG of Greeley, CO,
March 2013 issue, Random Access www.cugg.org, cugg@greeleynet.com
When is the last time you worried
about having the latest drivers for your
computer? Ever? Never? Yeah, me too.
Most people just don't give it any thought
beyond the initial install of a new piece
of hardware, but manufacturers tend to
release new drivers all the time. Even your
motherboard manufacturer sometimes
releases updates. Mouse drivers, NIC
drivers, USB bus drivers (there's probably
a joke there somewhere, but it escapes
me), hardware that no one ever thinks of
in their computers, that may not be running
the most current drivers. And really, why
should you care? Mostly because those
little outdated drivers might be the cause of
some significant computer problems.
For the most part, I'm a firm believer
in the old "if it ain't broke, don't fix it" approach to system maintenance, but on
more than one occasion, one or another
of my systems will BSoD for no apparent
reason. Microsoft's pathetic approach
to a diagnostic simply tells you that the
problem may have been caused by an
outdated driver. Well, duh ... Which one?
Yeah, yeah, I know that BSoD's don't exist
in the newer operating systems. But when
a computer does a hard reset while you're
in the middle of an hours-long project,
does it really matter what you call it?
Keeping those drivers current is a nightmare, because no one really keeps track
of the manufacturers and driver release
numbers for everything in every computer
they own. No one. Well, no one I know, or
would want to know I suspect. I am usually
doing well to keep my video and sound
card drivers current, and yes, I do use
discrete hardware plugins on my desktop
systems. Motherboard sound and video
is just not good enough for some of the
things I use my computers for, although it
is getting better all the time.
The good news is that there is a solution to this problem! Why else would I
be writing this article? Actually, there
have been a number of solutions to this
problem over the last decade or so, but
I have found none as user-friendly as a
little freeware program called SlimDrivers, available at www.slimwareutilities.
com. A recent article in MaximumPC
magazine introduced me to this cloud-
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based utility for keeping drivers current,
and it blew me away when I tried it.
Download the installer from the website listed above. Note that there are two
other free utilities they offer as well, one of
which, SlimCleaner, I am currently playing
around with. Run the installer and when
it's fully loaded, hit the big button labeled
Start Scan. It's just about that easy. (Do
be careful when accepting the install, as
they will try to install AVG Security Toolbar
into your browser, not a bad thing, but if
you're not into AVG you might not want
to have it auto-installed.) SlimDrivers then
goes out and uses "Crowd-sourcing to
spider and aggregate millions of devices"
to find drivers. In English, that means it
checks the hardware driver versions on
your computer, matches them against
the latest versions available online from
the manufacturer, and presents you with
a list of drivers for which updates are
available. For those concerned, SlimWare
Utilities is a Microsoft Gold Certified Partner, which means it should play very well
with Windows. I've successfully used it
on systems running Win8, Win7, Vista
and WinXP, and was very satisfied with
its ability to locate updated drivers on all 4
platforms. You are given the option to set
Restore points before any new drivers are
installed, and you can un-install or restore
drivers from within the program.
At this point, the shine wears off a little
bit, because you can only select one
driver at a time to update. The drivers
seem to download very slowly, and to be
honest I end up wondering if SlimDrivers is choking my download speed as
a way of enticing me to upgrade to their
paid version (DriverUpdate, $29.97/
one year license), or if I am just being
paranoid. And seriously, for freeware? I
can take the wait. I haven't been able to
discover whether or not that one license
would cover all my systems, or if I need
a separate license for each computer.
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Guess which one I would pay for... After
each update, you are advised to restart
your computer, and although you probably don't really "have" to do so each
time, I certainly recommend it. This of
course adds to the frustration of time
being consumed.
Has it prevented any more BSoD's on
my systems? Too early to tell, but I feel
a lot more comfortable knowing that I am
running the latest versions of hardware
drivers on my computers. This program
delivers, with a clean, easy-to-use (and
understand!) interface. Learn more about
it by visiting their website, www.slimwareutilities.com, and give it a shot.
Blue Screen of Death. If you don't remember those, you probably have not
been using a computer for very long.

CROSSWORD PUZZLE
Continued from Page 6

as a mental exercise. Thanks to its
clever shape and easy clues, it was a
success with readers. Eventually other
newspapers wanted to publish crossword puzzles, too.
By 1923, most newspapers in the
U.S. and Great Britain were publishing crosswords. Simon and Schuster
published the first crossword collection
book. The New York Times was one
of the only newspapers that did not
publish crosswords. It also frowned
on comic strips. However, the paper
eventually succumbed, and printed its
very first crossword in 1950.
Today crossword puzzles appear in
periodicals across the globe and can
even be produced at home with computer software.

May 2013

Crown Camera
Imaging Experts
Digital Cameras

M-F 8:30 - 5:30
Photo & Printer Supplies
Sat. 9 - 5
www.crowncamerashop.com
530-243-8333 or 800-655-4256
FAX: 530-243-4978

1365 Market Street
Redding, CA 96001

1730 Pleasant St., Redding, CA

(530) 241- 8646

CUGR
Membership Application
Name(s): _____________________________________________________
$24
Address: _____________________________________________________ Dues Per
City:________________________________ State: _________ Zip: _______ Year
Home Phone: __________________ Business Phone: ______________ ___
New
Renewal
E-mail Address: ________________________________________ _____ __
Cash
Date: __________
Check
Be Sure To MAIL TO:
Check #_________
CUGR
444 Balsalt Ct, Redding, CA 96003
(For general information call any Officer or Director listed on Page 2)
Not A Renewal Reminder

Interesting Sites To Visit On The Internet

Nancy Preffitt, Member, ICON UG, MO, 12-2012 issue, The ICON, www.iconusersgroup.com, ngpreffitt@juno.com

NO TIME TO READ?
If you find it difficult to set aside time
to read a good book, this site is for
you. Daily Lit offers a ”novel” solution!
It emails chapters of a selected book to
you every day thus allowing you to read
in smaller increments. Just browse the
database for a book you want to read,
enter your email address, and click
subscribe. Choose from best-selling
and award-winning titles, literary fiction
and romance to language learning and
science fiction. The site also features
forums, where you can discuss your
favorite books and authors.
http://www.dailylit.com/

AN OLD GAME IN A NEW TECHNOLOGY

Remember Yahtzee? You can now
play on your PC. It’s a single person
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game in this version. You can even
download it as a portable app and store
it on a thumb drive. It’s a geekly site –
as are most open source sites – but it’s
easy to download and enjoy without a
hassle. http://www.openyahtzee.org

MEDICATION INTERACTION?

It seems that the older we get, the more
prescriptions we have. Your doctor or
pharmacist may give you basic instructions (or not) but if you have an odd ache
or rash or something, what should you
do? The Physicians’ Desk Reference is
what doctors use and you can get it online
to acquire more information about drug
reactions and interactions, etc. Check it out
at http:// www.pdr.net. There’s a site just
for consumers which may be more understandable at http://www.drugs.com/pdr/
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AMAZING OLD PHOTOS
These photographs were taken from
color slides found at the Library of Congress. They’re dated from 1939-1943.
The colors are so bright and clear it’s
hard to imagine they’re so old. I enjoyed
the old vehicles, fashions and social
habits, too. http://extras.denverpost.
com/archive/captured.asp

TRYING TO PICK A GOOD MOVIE?

Make sure it's one you'll like by visiting Rotten Tomatoes first. It takes a
look at dozens of films now playing
at theaters, and collects reviews from
major critics. It also lets readers rank
the movies, which might provide the
best indication of the movie's quality.
http://www.rottentomatoes.com/movie/
in-theaters/
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PCUsers Group
of Redding
P.O. Box 494778
Redding, CA
96049-4778

Why Join A
Computer Group?

1. Benefit from a common interest in a
personal (and costly) investment: Your
business or personal computer.
2. Enjoy more of that investment by
learning more about it.
3. Share tips and tricks, as well as new
and old ideas.
4. Become exposed to a variety of new
hardware and software without sales
pressure.
5. Receive an informative monthly newsletter.
6. Have access to various club functions and all Special Interest Groups
(SIGs).
7. Find out that no one needs to be alone
and helpless with today’s computer
technology.

4th Tuesday
Monthly Meetings Are At

The Redding Library
1100 Parkview Ave.

off Cypress and to the right of City Hall.
We will be in the Community Room, which is inside to the
left of the main library door.

Multi-Media SIG
Saturday, 10 AM, June 22, 2013
At Jane Quinn’s Home, for information contact:

Jane Quinn, 365-0825, qjquinn7427@gmail.com
Learn about Digital Devices, usage of free software for Movie Creation, Photo Projects, Music Projects, and Social Networking.
Includes Microsoft Windows 7 basic Instruction.
Jane also conducts classes at the Anderson Senior Center
(Frontier Center), Thursday 1-3 pm. You can connect to the classroom via high-speed internet to SKYPE, ID # AAASCO2009.
Walk-ins welcome between 3 & 4 pm for tutoring or special projects.
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